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QIAGEN is the leading provider of innovative sample and assay technologies,
enabling the isolation and detection of contents of any biological sample. Our
advanced, high-quality products and services ensure success from sample to
result.

QIAGEN sets standards in:

M Purification of DNA, RNA, and proteins

M Nucleic acid and protein assays

B microRNA research and RNAI

M Automation of sample and assay technologies

Our mission is to enable you to achieve outstanding success and
breakthroughs. For more information, visit www.giagen.com.
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artus VZV TM PCR Kit

For use with the ABI PRISM 7000, 7700 and 7900HT Sequence Detection
Systems.

Attention: The artus VZV TM PCR Kit may neither be used in combination with
the GeneAmp® 5700 SDS nor with the 384 plate format of the ABI PRISM
7900HT SDS.

1. Contentis

Art. No. 4502163 Art. No. 4502165
Labelling and contents 24 reactions 96 reactions

VZV TM Master 2 x 12 rxns 8 x 12 rxns
VZV LC/TM QS TX 1 x 200 ul 1 x 200 ul

1 x 10* cop/ ul

VZV LC/TM QS 28 1 x 200 ul 1 x 200 ul

1 x 10° cop/ul

VZV LC/TM QS 3R 1 x 200 ul 1 x 200 ul

1 x 10 cop/ul

VZV LC/TM QS 4X 1 x 200 ul 1 x 200 ul

1 x 10" cop/ul

VZV TM ICH 1 x 1,000 ul 2 x 1,000 ul
White Water (PCR grade) 1 x 1,000 ul 1 x 1,000 ul

XQS = Quantitation Standard
IC = Internal Control

2. Storage

The components of the artus VZV TM PCR Kit should be stored at -30°C to
—-15°C and are stable until the expiry date stated on the label. Repeated thawing
and freezing (> 2 x) should be avoided, as this may reduce the sensitivity. If the
reagents are to be used only intermittently, they should be frozen in aliquots.
Storage at +4°C should not exceed a period of five hours.
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3. Additionally Required Materials and Devices

Disposable powder-free gloves

DNA isolation kit (see 8.1 DNA Isolation)

Pipettes (adjustable)

Sterile pipette tips with filters

Vortex mixer

Desktop centrifuge with rotor for 2 ml reaction tubes
Centrifuge with rotor for microtitre plates (optional)

96-well reaction plate/reaction tubes for optical measurement with
corresponding optical closing materials* (see 8.4 Preparing the PCR)

96-well two-part retaining rack for use with optical reaction tubes (96-Well
Tray/Retainer Set, Cat. No. 403 081, Applied Biosystems), see
8.4 Preparing the PCR

Compression pad for use with optical adhesive covers (Optical Cover
Compression Pads, Cat. No. 4 312 639, Applied Biosystems), see
8.4 Preparing the PCR

Applicator for sealing of the reaction plates using optical adhesive covers
(Adhesive Seal Applicator Kit, Cat. No. 4 333 183, Applied Biosystems)

ABI PRISM 7000, 7700 or 7900HT SDS

Attention: A valid calibration of the pure dyes (Pure Spectra Component File)
and the background (Background Component File) is necessary when putting
the instruments into operation.

4. General Precautions

The user should always pay attention to the following:

Use sterile pipette tips with filters.

Store and extract positive material (specimens, controls and amplicons)
separately from all other reagents and add it to the reaction mix in a
spatially separated facility.

Thaw all components thoroughly at room temperature before starting an
assay.

When thawed, mix the components and centrifuge briefly.

Work quickly on ice or in a cooling block.

* The use of reaction tubes for optical analyses with domed caps is only permitted with the ABI
PRISM 7700 SDS and requires an adjustment of the exposure time (see 8.5.2 Programming
the ABI PRISM 7700 SDS, 8.5.2.5 Important Additional Settings).
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5. Pathogen Information

The varicella-zoster virus (VZV) is transmitted from person to person as a droplet
infection or by direct contact. The VZV infection causes slightly raised
temperatures and affects the general health to a moderate extent. Polymorphic
exema with welts, blisters and scabs along with severe itching (chicken pox) are
characteristic of the illness. Severe VZV infections are frequently observed with
immunosuppressed patients and can result in dangerous complications such as
pneumonia and encephalitis. After the acute infection, the pathogens persist in
the sensory spinal ganglia and in the ganglia of the cranial nerves. If immunity
is weakened exacerbations can occur (e.g. labial herpes, shingles).

6. Principle of Real-Time PCR

Pathogen diagnosis by the polymerase chain reaction (PCR) is based on the
amplification of specific regions of the pathogen genome. In real-time PCR the
amplified product is detected via fluorescent dyes. These are usually linked to
oligonucleotide probes which bind specifically to the amplified product.
Monitoring the fluorescence intensities during the PCR run (i.e. in real-time)
allows the detection and quantitation of the accumulating product without
having to re-open the reaction tubes after the PCR run (Mackay, 2004).

7. Product Description

The artus VZV TM PCR Kit constitutes a ready-to-use system for the detection of
VZV DNA using polymerase chain reaction (PCR) in the ABI PRISM 7000, 7700
and 7900HT Sequence Detection System. The VZV TM Master contains reagents
and enzymes for the specific amplification of a 82 bp region of the VZV
genome. The amplicon is detected by measuring the FAM fluorescence in the
ABI PRISM SDS. In addition, the artus VZV TM PCR Kit contains a second
heterologous amplification system to identify possible PCR inhibition. This is
detected as an Internal Control (IC) by measuring the VIC fluorescence. The
detection limit of the analytical VZV PCR (see 11.1 Analytical Sensitivity) is not
reduced. External positive controls (VZV LC/TM QS 1 — 4) are supplied which
allow the determination of the pathogen load. For further information, please
refer to section 8.3 Quantitation.
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8. Protocol

8.1 DNA Isolation

Various manufacturers offer DNA isolation kits. Sample amounts for the DNA
isolation procedure depend on the protocol used. Please carry out the DNA
isolation according to the manufacturer’s instructions. The following isolation
kits are recommended:

Sample Nucleic Acid Number Carrier
Material Isolation Kit Catalogue Manufacturer RNA
Serum, plasma, QlAamp® 53 704 QIAGEN included
CSF, swabs UltraSens® Virus
Kit (50)

QIAamp DNA 51 304 QIAGEN not

Mini Kit (50) included
CSF EZ1® DSP Virus Kit 62 724 QIAGEN included

(48)

*To be used in combination with the BioRobot EZ1® DSP Workstation (Cat. No. 9001360) and
the EZ1 DSP Virus Card (Cat. No. 9017707).

Important note for the use of the QIAamp UltraSens Virus Kit and the
QIlAamp DNA Mini Kit:

B The use of carrier RNA is critical for the extraction efficiency and,
consequently, for DNA/RNA yield. If the selected isolation kit does not
contain carrier RNA, please note that the addition of carrier
(RNAHomopolymer Poly(A), Amersham Biosciences, Cat. No. 27-4110-01)
is strongly recommended for the extraction of nucleic acids from cell free
body fluids and material low in DNA/RNA content (e.g. CSF). Please
proceed as follows in these cases:

a) Resuspend the lyophilised carrier RNA using the elution buffer (do not use
lysis buffer) of the extraction kit (e.g. AE buffer of the QlAamp DNA Mini Kit)
and prepare a dilution with a concentration of 1 ug/ul. Divide this carrier
RNA solution in a number of aliquots adequate to your needs and store
them at —20°C. Avoid repeated thawing (> 2 x) of a carrier RNA aliquot.

b) Use 1 ug carrier RNA per 100 ul lysis buffer. For instance, if the
extraction protocol suggests 200 ul lysis buffer, please add 2 ul carrier
RNA (1 ug/ul) directly into the lysis buffer. Before beginning of each
extraction, a mixture of lysis buffer and carrier RNA (and Internal Control,
where applicable, see 8.2 Internal Control) should be prepared freshly
according to the following pipetting scheme:
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Number of samples 1 12

Lysis buffer e.g. 200 ul e.g. 2,400 ul
Carrier RNA (1 ug/ul) 2 ul 24 ul
Total Volume 202 ul 2,424 ul
Volume per extraction 200 ul each 200 ul

c) Please use the freshly prepared mixture of lysis buffer and carrier RNA
instantly for extraction. Storage of the mixture is not possible.

The use of carrier RNA is critical for the extraction efficiency and,
consequently, for DNA/RNA yield. To increase the stability of the carrier
RNA provided with the QlAamp UliraSens Virus Kit, we recommend the
following procedure deviant from the user manual of the extraction kit:

a) Resuspend the lyophilised carrier RNA prior to first use of the extraction
kit in 310 ul of the elution buffer provided with the kit (final concentration
1 ug/ul, do not use lysis buffer). Portion this carrier RNA solution into a
number of aliquots adequate to your needs and store them at —20°C.
Avoid repeated thawing (> 2 x) of a carrier RNA aliquot.

b) Before the beginning of each extraction, a mixture of lysis buffer and
carrier RNA (and Internal Control, where applicable, see 8.2 Internal
Control) should be prepared freshly according to the following pipetting
scheme:

Number of samples 1 12

Lysis buffer AC 800 ul 9,600 ul
Carrier RNA (1 ug/ul) 5.6 ul 67.2 ul
Total Volume 805.6 ul 9,667.2 ul
Volume per extraction 800 ul each 800 ul

c) Please use the freshly prepared mixture of lysis buffer and carrier RNA
instantly for extraction. Storage of the mixture is not possible.

It is recommended to elute the DNA in 50 ul elution buffer to get the
highest sensitivity of the artus VZV TM PCR Kit.
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B The QlAamp UltraSens Virus Kit allows a sample concentration. If you
use sample material other than serum or plasma, please add at least 50 %
(v/v) of negative human plasma to the sample.

B When using isolation protocols with ethanol-containing washing buffers,
please carry out an additional centrifugation step (three minutes,
13,000 rpm) before the elution to remove any remaining ethanol. This
prevents possible inhibition of PCR.

M The artus VZV TM PCR Kit should not be used with phenol-based isolation
methods.

Important note for the use of the EZ1 DSP Virus Kit:

B The use of carrier RNA is critical for the extraction efficiency and,
consequently, for DNA/RNA yield. Please add the appropriate amount of
carrier RNA to each extraction following the instructions in the EZT DSP
Virus Kit Handbook.

Important: The Internal Control of the artus VZV TM PCR Kit can be used
directly in the isolation procedure (see 8.2 Internal Control).

8.2 Internal Control

An Internal Control (VZV TM IC) is supplied. This allows the user both to
control the DNA isolation procedure and to check for possible PCR
inhibition (see Fig. 1). Using the EZ1 DSP Virus Kit for extraction, the Internal
Control has to be added following the instructions in the EZ1 DSP Virus Kit
Handbook. Using the QlAamp UltraSens Virus Kit or the QIAamp DNA
Mini Kit, add the Internal Control to the isolation at a ratio of 0.1 ul per 1 ul
elution volume. For example, using the QlAamp DNA Mini Kit the DNA is eluted
in 50 ul AE buffer. Hence, 5 ul of the Internal Control should be added initially.
The quantity of Internal Control used depends only on the elution volume. The
Internal Control and carrier RNA (see 8.1 DNA Isolation) should be added only

B to the mixture of lysis buffer and sample material or
M directly to the lysis buffer.

The Internal Control must not be added to the sample material directly. If added
to the lysis buffer please note that the mixture of Internal Control and lysis
buffer/carrier RNA has to be prepared freshly and used instantly (storage of the
mixture at room temperature or in the fridge for only a few hours may lead to
Internal Control failure and a reduced extraction efficiency). Please do not add
the Internal Control and the carrier RNA to the sample material directly.

The Internal Control can optionally be used exclusively to check for possible
PCR inhibition (see Fig. 2). For this application, add 2 ul of the Internal Control
per reaction directly to 30 ul VZV TM Master. For each PCR reaction use 30 ul
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of the Master Mix produced as described above* and add 20 ul of the purified
sample. If you are preparing a PCR run for several samples please increase the

volume of the VZV TM Master, the VZV TM Mg-Sol and the Internal Control
according to the number of samples (see 8.4 Preparing the PCR).

8.3 Quantitation

The enclosed Quantitation Standards (VZV LC/TM QS 1 - 4) are treated as
previously purified samples and the same volume is used (20 ul). To generate a
standard curve on an ABI PRISM Sequence Detection System, all four
Quantitation Standards should be used and defined as standards with
specification of the corresponding concentrations (see 8.5 Programming the ABI

PRISM SDS). The import of standard curves from previous runs is not possible
with the ABI PRISM 7000, 7700 and 7900HT SDS software.

Attention: The Quantitation Standards are defined as copies/ul. The following
equation has to be applied to convert the values determined using the standard
curve into copies/ml of sample material:

Result (copies/ml) - Result (copies/ul) x Elution Volume (ul)

Sample Volume (ml)

Please note that as a matter of principle the initial sample volume should be
entered in the equation above. This has to be considered when the sample
volume has been changed prior to the nucleic acid extraction (e.g. narrowing
the volume by centrifugation or increase of volume by replenishment to the
volume required for the isolation).

Important: A guideline for the quantitative analysis of artus systems on the ABI
PRISM 7000 SDS is provided at
www.qgiagen.com/Products/ByLabFocus/MDX (Technical Note for
quantitation on the ABI PRISM 7000 SDS).

8.4 Preparing the PCR

Prepare the number of required reaction tubes or a 96-well reaction plate for
the scheduled reactions. Recommended materials are listed in the following
table:

* The volume increase caused by adding the Internal Control is neglected when preparing the
PCR assay. The sensitivity of the detection system is not impaired.
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Catalogue Retaining Compression

Article Description Number Manufacturer Rack’ Pad
96-well 96-Well 4 306 737 Applied no -
optical Optical Biosystems
reaction  Reaction
plate Plate
Optical Optical 4311 971 Applied - Yes
adhesive  Adhesive Biosystems
covers Covers
Optical  ABI PRISM 4 316 567 Applied yes -
reaction Optical Biosystems
tubes Tubes, 8

Tubes/Strip
Optical  MicroAmp® N8010933 Applied yes -
reaction Optical Biosystems
tubes Tubes
Optical ~ ABI PRISM 4 323 032 Applied - no
caps Optical Biosystems
(flat) Caps, 8

Caps/Strip

Attention: The use of reaction tubes for optical analyses with domed caps is
only permitted with the ABI PRISM 7700 SDS and requires an adjustment of the
exposure time (see 8.5.2 Programming the ABI PRISM 7700 SDS,

8.5.2.5 Important Additional Settings).

When preparing the PCR reaction, please make sure that at least one
Quantitation Standard per PCR run as well as one negative control (Water, PCR
grade) are performed in parallel. To generate a standard curve, use all

supplied Quantitation Standards (VZV LC/TM QS 1 — 4) for each PCR run.
Before each use, all reagents need to be thawed completely, mixed (by
repeated up and down pipetting or by quick vortexing) and centrifuged briefly.

If you want to use the Internal Control to monitor the DNA isolation
procedure and to check for possible PCR inhibition, it has already been
added to the isolation (see 8.2 Internal Control). In this case, please use the
following pipetting scheme (for a schematic overview see Fig. 1):

" If the two-part retaining rack is used, it is necessary to open the reaction tubes when inserting
them into and removing them from the rack. In order to avoid contamination due to this
procedure, please use the lower part of the retaining rack only.
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Number of samples 1 12

1. Preparation of Master Mix VZV TM Master 30ul 360 ul
VZVTM IC 0 ul o ul
Total Volume 30ul 360 ul
2. Preparation of PCR assay Master Mix 30 ul 30 ul each
Sample 20 ul 20 ul each

Total Volume 50 ul 50 ul each

If you want to use the Internal Control exclusively to check for PCR inhibition,
it must be added directly to the VZV TM Master. In this case, please use the
following pipetting scheme (for a schematic overview see Fig. 2):

Number of samples 1 12
1. Preparation of Master Mix VZV TM Master 30 ul 360 ul
VZV TM IC 2 ul 24 ul
Total Volume 32 ul* 360 ul*
2. Preparation of PCR assay Master Mix 30 ul* 30 ul each*
Sample 20 ul - 20 ul each

Total Volume 50 ul 50 ul each

Pipet 30 ul of the Master Mix into each required reaction tube or well of the 96-
well reaction plate. Subsequently add 20 ul of the eluate from the DNA
isolation. Mix the solution well by repeated up and down pipetting. Close the
reaction tubes with the corresponding caps or, alternatively, when using a 96-
well reaction plate, with optical adhesive covers (Optical Adhesive Covers).
Centrifuge the reaction tubes (in a storage rack for PCR tubes) or the 96-well
reaction plate in a centrifuge with a microtitre plate rotor for 30 seconds at
1,780 x g (4,000 rpm) in order to collect the prepared reaction volume in the
bottom of the tube or well. If such a centrifuge is not at your disposal, please
make sure that both the Master Mix and the sample volume are pipetted to the
bottom of the tubes or wells. Store the prepared reactions at +4°C until the ABI

* The volume increase caused by adding the Internal Control is neglected when preparing the
PCR assay. The sensitivity of the detection system is not impaired.
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PRISM SDS Instrument is programmed (see 8.5 Programming the ABI PRISM
SDS) and subsequently transfer them into the instrument.

Attention:

B When using optical reaction tubes in combination with optical caps, always
insert a retaining rack (96-Well Tray/Retainer Set) into the instrument (ABI
PRISM 7000, 7700 and 7900HT SDS). If the two-part retaining rack is used,
it is necessary to open the reaction tubes when inserting them into and
removing them from the rack. In order to avoid contamination due to this
procedure, please use the lower part of the retaining rack only.

B Using 96-well optical reaction plates in combination with optical adhesive
covers requires covering by a compression pad (Optical Cover
Compression Pads).

L. |
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Addition of the Internal Control to the Purification Procedure

Fig. 1: Schematic workflow for the control of both the purification procedure and PCR
inhibition.

*Please make sure that the solutions are thawed completely, mixed well and centrifuged
briefly.
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Addition of the Internal Control into the artus Master

Fig. 2: Schematic workflow for the control of PCR inhibition.

*Please make sure that the solutions are thawed completely, mixed well and centrifuged
briefly.
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8.5 Programming the ABI PRISM SDS

The software of the ABI PRISM 7000, 7700 and 7900HT Sequence Detection
Systems (SDS) requires some additional information before starting the PCR run.
The programming procedures of the instruments, however, differ considerably
from each other, which is why they are treated in separate chapters as follows.

8.5.1 Programming the ABI PRISM 7000 SDS

For the detection of VZV DNA, create a profile on your ABI PRISM 7000 SDS
according to the following six steps (8.5.1.1 — 8.5.1.6). All specifications refer to
the ABI PRISM 7000 SDS software version 1.0.1. For programming details of the
ABI PRISM 7000 SDS, please refer to the ABI PRISM 7000 SDS User Guide. For a
better overview, the software settings are framed in bold black.

8.5.1.1 Pre-Settings for Creating a New PCR Run

Select the item New from the File menu on the ABI PRISM 7000 SDS and
programme the following initial settings for the new document (see Fig. 3). A
backup template (SDS Template [*.sdt]) is available from the Template list or by
selection using the Browse function (see 8.5.1.5 Saving the PCR Run). Confirm
your pre-settings (OK).

=
Container : |95—We|| Clear b _1
Template : IBIankDocument 2

Browse ... |

[ 2

oK Cancel |

Fig. 3: Pre-settings for creating a new PCR run (New Document).
8.5.1.2 Creating/Selecting the Detectors

With the help of the submenu Detector Manager from the Tools menu, assign
the corresponding detector dyes to the file. For the detection of VZV DNA as
well as the Internal Control by means of the artus VZV TM PCR Kit, the
reporters/quenchers listed in the following table are to be defined:

Detection Reporter Quencher
VZV DNA FAM TAMRA
Internal Control (VZV TM IC) VIC None
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To create these detectors, select the option File (bottom left of the Detector
Manager) and subsequently the option New.

Name: [artus V2V Mame: [artus VZVIC
Descripiion: |anus VEV TMFCRKit Description; |adusVZ\fTM PCR Kit
1— Reporter Dye: IF'AM L’ Repotter Dye: IVIC L’ JE— 1
Quencher Dye: | TAMRA =] Quencher Dye: |(nune) LI
Calor, . Color T_EI
s .
Notes: Notes

MI m ﬂl Create Another Cancel |
Fig. 4: Creating the VZV specific detector Fig. 5: Creating the IC specific detector
(Detector Manager). (Detector Manager).

For the detection of VZV DNA define the reporter/quencher combination
FAM/TAMRA in the new window. For the detection of the Internal Control,
select the combination VIC/none (as shown in Fig. 4 and Fig. 5). By confirming
the input data (OK), return to the Detector Manager. Mark the newly created
detectors and transfer each selection to the Well Inspector by clicking on the
option Add to Plate Document (see Fig. 6). Close the window (Done).

Detector Manager N X|
Detector List
Find: | ;I j
Detector Name [ Description Reporter ] Quencher |Color| Notes | Last Modified =+
antus VIV artus VIV TM PCR Kit FAM TAMRA
artus VIV IC artug VIV T PCR Kit WIC ({none)
e 1
b4
4 l | »
Fila = | I Add To Flate Document .I 2

-3

Fig. 6: Selecting the detectors (Detector Manager).
8.5.1.3 Assigning the Necessary Information to the Plate Positions

Open Well Inspector from the View menu to find the detectors selected under
8.5.1.2 (see Fig. 7).

L. |
artus VZV TM PCR Kit 03/2015 17



well Inspector x|
Well(s): Al
Sample Name: IOS1

Detector Reporter | Quencher Task Quantity | Color]
W lartus VIV FAM TAMRA | Standar »

W |atus VZVIC [VIC (none) [Unknown | | — 1

Standard

NTC

<| | i
[~ OmitWell
Passive
«dd Detector|  Remove | [Rox ~| P

Fig. 7: Assigning the necessary information to the plate positions (Well Inspector).

Mark the plate positions reserved for the detection of VZV DNA. Assign the
selected detectors to these positions by activating the Use option of both
detectors, upon which a tick will appear. For the denomination of each single
reaction, select the corresponding position on the plate and enter the name
(Sample Name). Please note that preparations with an identical Sample Name
and an identical detector assignment will be identified as replicates by the
software and will be averaged with respect to the quantified pathogen load.

Then select the corresponding function (Task) for each sample type according to
the following table:

Function Concentration
Sample Type (Task) (Quantity) Reporter Quencher
Sample Unknown - FAM TAMRA
Non-template NTC - FAM TAMRA
control
Standard Standard see 1. Contents FAM TAMRA

To generate a standard curve, use all supplied Quantitation Standards (VZV
LC/TM QS 1 — 4) per PCR run and enter the corresponding concentrations (see
1. Contents) for each standard (Quantity). Please note that for a PCR run with
the artus VZV TM PCR Kit, ROX has to be set as a passive reference (Passive
Reference). The equal distribution of the ROX dye in all PCR preparations of a
lot by mixing of the VZV TM Master guarantees the recognition and calculation
of tube-to-tube variations (fluorescence differences between several PCR
preparations) by means of the Sequence Detection Software (normalization).

8.5.1.4 Creating the Temperature Profile

To create a temperature profile, switch from the Setup level to the Instrument
level in the software. Enter the temperature profile specific for the detection of
VZV DNA according to Fig. 8. In order to remove the 50°C step stored in the
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pre-settings, mark it with the left mouse button simultaneously holding the shift
key, and subsequently delete it by using the backspace key. Make sure that the
reaction volume is set to 50 ul. The option 9600 Emulation should be activated,

the pre-settings of the Auto Increment should remain unchanged (Auto

Increment: 0.0°C, 0.0 Seconds).

— Thermal Cycler Protocol -
Thermal Profile | Auta Increment

Stage 1 Stage 2

lReps‘.l:! Reps :E

ES.D 050
II{!III:IIIIII 0:30
pio |
Add Oycte | AddHold | AddStep [ Jamele Volume
I” Dissociation Protocol
IF 9600 Emulation :

Fig. 8: Creating the temperature profile.
8.5.1.5 Saving the PCR Run

Save the settings (Setup) as a template in order to make use of them again later

in a modified or unchanged form. By saving the Template file as a SDS
Template (*.sdft) in the Template Directory (Local Disk [C:]\Program Files\ABI
PRISM 7000\Templates, created by Applied Biosystems), this file may be
selected directly in the New Document window from the Template drop-down
list. Copies stored in other folders have to be opened via Browse. Before
starting the PCR run, save it again as a SDS Document (*.sds), in order to

guarantee the saving of the data that will be collected during the course of the

PCR.

8.5.1.6 Starting the PCR Run

Start the PCR run by selecting the option Start from the menu item Instrument or
the field Start on the Instrument level.

8.5.2 Programming the ABI PRISM 7700 SDS

For the detection of VZV DNA, create a profile on your ABI PRISM 7700 SDS
according to the following seven steps (8.5.2.1 — 8.5.2.7). All specifications
refer to the ABI PRISM 7700 SDS software version 1.9.1. For programming

details of the ABI PRISM 7700 SDS, please refer to the ABI PRISM 7700 SDS

User's Manual. For a better overview, the software settings are framed in bold

black.
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8.5.2.1 Pre-settings for Creating a New PCR Run

Select the item New Plate from the File menu on the ABI PRISM 7700 SDS and
programme the following initial settings for the new document (see Fig. 9).
Confirm the pre-settings (OK).

New Plate
Plate Type: [ Single Reporter [=]
—Data Acquisition 1

Plate Format:  [Standard Plate | 3]

Run: [ Real Time =]

Co -2

Fig. 9: Pre-settings for creating a new PCR run (New Plate).

8.5.2.2 Selecting the Fluorescence Dyes and Assigning the Sample Type

With the help of the Sample Type Setup (Setup level: Sample Type/Sample Type
Setup) assign the corresponding detector dyes and the corresponding sample
type to the file. For the detection of VZV DNA as well as the Internal Control by
means of the artus VZV TM PCR Kit, the reporters/quenchers listed in the
following table are to be defined: field Start on the Instrument level.

Detection Reporter Quencher
VZV DNA FAM TAMRA
Internal Control (VZV TM IC) VIC TAMRA

For the analysis of VZV DNA by means of the artus VZV TM PCR Kit, select the
reporter dye FAM as given in the table. This applies to standards (STND) and
samples (UNKN) as well as to non-template controls (UNKN). For the analysis
of the Internal Control (IPC+), define VIC as reporter. As quencher set TAMRA.
The assignment of the dyes and sample types in the window Sample Type Setup
is shown in Fig. 10.

|
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Sample Type Setup

Acronym HName Color Reporter

Standard
[unkn | [unknown [ ] [Fam [ |
[unke | Mo Template Control || | [Fam = |
|IPC-'- I |InternalPositive “ | ['v'ic i] 1
Reference ¥ Quencher
REA —2

e [cancer ] |Cax -3

Fig. 10: Selecting the fluorescence dyes and assigning the sample type (Sample Type Setup).

Please assign the sample type to a corresponding function (Acronym) according
to the following table:

Function Concentration
Sample Type (Acronym) (Quantity) Reporter Quencher
Sample UNKN - FAM TAMRA
Non-template UNKN - FAM TAMRA
control
Standard STND see 1. Contents FAM TAMRA

8.5.2.3 Assigning the Necessary Information to the Plate Positions

For the assignment of the detectors and sample types to the individual plate
positions, select the corresponding fields. Then open the dialogue window Dye
Layer on the Setup level and assign the corresponding reporter. Upon activation
of the pop-up menu Sample Type, you will find the sample types assigned to the
reporter in the Sample Type Setup in the appearing list (see Fig. 11). Select the
adequate sample type (see Table under 8.5.2.2) and assign the remaining plate
positions by means of the Dye Layers and the Sample Type menu. A name may
be assigned to each sample in the field Sample Name. Fields defined as
Replicates (entering of the name of the reference sample into the Replicate
column) are averaged by the software with respect to the quantified pathogen
load and the standard deviation will be calculated.
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Fig. 11/12: Assigning the necessary information to the plate positions.

To generate a standard curve, use all supplied Quantitation Standards (VZV
LC/TM QS 1 — 4) per PCR run and enter the corresponding concentrations (see
1. Contents) for each standard into the field Quantity (see Fig. 12). This is only
possible, however, if the positions reserved for standards were defined as such
before by means of the Sample Type menu.

8.5.2.4 Creating the Temperature Profile

To create a temperature profile, switch to the Thermal Cycler Conditions menu
on the Setup level. Enter the temperature profile specific for the detection of VZV
DNA according to Fig. 13. Make sure that the reaction volume is set to 50 ul.
The pre-settings of the Ramp times and of the Auto Increment remain
unchanged (Ramp Time: 0:00, Auto Increment: 0.0°C, 0.0 Seconds).

-Thermal Cycler Conditions:
Stagel Stage2
Repeat
1
KD
itk LACEs Auto Increment Sample Yolume Show Data Collection l
i | oxec S0 W 2
St | 52 seconds
3

Fig. 13: Creating the temperature profile.

In addition, the Thermal Cycler Conditions menu contains the option Show Data
Collection. By selecting this option the window depicted in Fig. 14 is opened.
Each ramp and each plateau temperature shows a Data Collection Icon, which
illustrates the data being collected at this stage of the run.
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Remove all symbols except the one for the Annealing-Extension step
(Stage2/Step2) in order to exclude unnecessary fluorescence measurements.
The total run time and the data quantity will thus be kept at a minimum.

-Thermal Cycler Conditions -

Stagel Stage2
Repeat

[«]»]

Auto Increment Sample Yolume Show Time And Temp |
O o | 50 A
] (. Seconds

(Conce )| o Jf=1-2

Fig. 14: Data collection.
8.5.2.5 Important Additional Settings

For the setting of the exposure time (excitation of the fluorescence dyes) as well
as for the selection of the Pure Spectra/Background files, switch from the Setup
level to the Analysis level. Select the activated sub-item Advanced Options to be
found in the Instrument menu under Diagnostics. Adjust the settings according
to Fig. 15. By inactivating the optional function Spectra Components (Analysis)
the actual calibration files stored in the file Spectra Components at the moment
of data generation are automatically used when re-evaluating already analysed
runs. For an analysis of previous runs by using newly entered Spectra
Components, activate these two fields. Please note that for a PCR run with the
artus VZV TM PCR Kit, ROX has to be set as a passive reference (Reference).
The equal distribution of the ROX dye in all PCR preparations of a lot by mixing
of the VZV TM Master guarantees the recognition and calculation of tube-to-
tube variations (fluorescence differences between several PCR preparations) by
means of the Sequence Detection Software (normalization).

Attention: When using 96-well reaction plates for optical measurements in
combination with optical adhesive covers or optical reaction tubes with flat
caps, the exposure time is ten milliseconds. If you use optical reaction tubes
with domed caps, you have to adjust this exposure time to 25 milliseconds.

L. |
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Fig. 15: Important additional settings (Advanced Options).
8.5.2.6 Saving the PCR Run

Save the settings (Setup) as a template in order to make use of them again later
in a modified or unchanged form. For this purpose store the file in the
Stationary File Format. Before starting a newly programmed PCR run, please
save it again in the Normal File Format in order to guarantee the saving of data
that will be collected during the course of the PCR.

8.5.2.7 Starting the PCR Run

Start the PCR run by selecting the option Run from the menu item Instrument or
the field Run on the Analysis level.

8.5.3 Programming the ABI PRISM 7900HT SDS

For the detection of VZV DNA, create a profile on your ABI PRISM 7900HT SDS
according to the following six steps (8.5.3.1 — 8.5.3.6). All specifications refer to
the ABI PRISM 7900HT SDS software version 2.1. For programming details of
the ABI PRISM 7900HT SDS, please refer to the ABI PRISM 7900HT SDS User
Guide. For a better overview, the software settings are framed in bold black.

8.5.3.1 Pre-Settings for Creating a New PCR Run

Select the item New from the File menu on the ABI PRISM 7900HT SDS and
programme the following initial settings for the new document (see Fig. 16). A
backup template (ABI PRISM SDS Template Document [*.sdt]) is available from

the Template list or by selection using the Browse function (see 8.5.3.5 Saving
the PCR Run). Confirm the pre-settings (OK).

Attention: The artus VZV TM PCR Kit may not be used in combination with the
384 plate format of the ABI PRISM 7900HT SDS.
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Fig. 16: Pre-settings for creating a new PCR run (New Document).

8.5.3.2 Creating/Selecting the Detectors

With the help of the submenu Detector Manager from the Tools menu
(alternatively: Setup level/Add Detector select function), assign the
corresponding detector dyes to the file. For the detection of VZV DNA as well as
the Internal Control by means of the artus VZV TM PCR Kit, the
reporters/quenchers listed in the following table are to be defined:

Detection Reporter Quencher
VZV DNA FAM TAMRA
Internal Control (VZV TM IC) VIC Non Fluorescent

To create these detectors, select the option New (bottom left of the Detector
Manager).

L. |
artus VZV TM PCR Kit 03/2015 25



Add Detector [x] Add Detector [x]

Narme: | artus V2V Natne: I artus VZVIC
: | artus VZv TH PCR Kit Deserigtion: | artus V2V TM PCR Kit
T 1
1 Reporter: [FAM > Reporter: im
Quencher: ,m Quencher: l}‘m
Color: - Color: ,—
Notes: hotes:

Cancel I Cancel
Fig. 17: Creating the VZV specific detector Fig. 18: Creating the IC specific detector
(Detector Manager). (Detector Manager).

For the detection of VZV DNA define the reporter/quencher combination
FAM/TAMRA in the new window. For the detection of the Internal Control,
select the combination VIC/Non Fluorescent (as shown in Fig. 17 and

Fig. 18). By confirming the input data (OK), return to the Detector Manager.
Mark the newly created detectors and transfer each selection to the Setup level
by clicking on the option Copy to Plate Document (see Fig. 19). Close the
window (Done).

Detector Manager
Finl: ! _AJ] ll
I Platne I Reporter ] Ciuencher ﬂ Cu:ulurl Modification Date i 1
arius VI Fith TAMRA — -
arLs VIV T WIC Mon Fluorescert
‘ -
[l .. I JpeEn | Save A5, I Import. .. I Expoart... I l Copy To Plate Diocumert r— 2
]

Fig. 19: Selecting the detectors (Detector Manager).
8.5.3.3 Assigning the Necessary Information to the Plate Positions

After having closed the Detector Manager (Done) the detectors selected under
8.5.3.2 are found on the Setup level listed in a table (see Fig. 20).

L. |
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Fig. 20: Assigning the necessary information to the plate positions.

Mark the plate positions reserved for the detection of VZV DNA. Assign the
selected detectors to these positions by activating the Use option of both
detectors, upon which a cross will appear. For the denomination of each single
reaction, select the corresponding position on the plate and enter the name
(Sample Name). Please note that preparations with an identical Sample Name
and an identical detector assignment will be identified as replicates by the
software and will be averaged with respect to the quantified pathogen load.
Then select the corresponding function (Task) for each sample type according to
the following table:

Function Concentration
Sample Type (Task) (Quantity) Reporter Quencher
Sample Unknown - FAM TAMRA
Non-template NTC - FAM TAMRA
control
Standard Standard see 1. Contents FAM TAMRA

To generate a standard curve, use all supplied Quantitation Standards (VZV
LC/TM QS 1 — 4) per PCR run and enter the corresponding concentrations (see
1. Contents) for each standard (Quantity). Please note that for a PCR run with
the artus VZV TM PCR Kit, ROX has to be set as a passive reference (Passive
Reference). The equal distribution of the ROX dye in all PCR preparations of a
lot by mixing of the VZV TM Master guarantees the recognition and calculation
of tube-to-tube variations (fluorescence differences between several PCR
preparations) by means of the Sequence Detection Software (normalization).
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8.5.3.4 Creating the Temperature Profile

To create a temperature profile, switch from the Setup level to the Instrument
level in the software. Enter the valid temperature profile for the detection of VZV
DNA according to Fig. 21. Make sure that the reaction volume is set to 50 ul.
The option 9600 Emulation should be activated, the pre-settings of the Ramp
time and the Auto Increment should remain unchanged (Ramp Time: 0:00, Auto
Increment: 0.0°C, 0.0 Seconds).

Setup  Instrument |

&
[~Thermal Cycler Protocol
| Thermal Profile | auto increment] Ramp Rate| Data Callection | :
! Stage 1 Stage 2 =
i Repeats [45
| 5.0 [o5.0
. 10:00 [o:30
| 1
| (st =
5 55,0
| o al
| 1.00
; e
Add Cycle | Add Hold | Add Step | Delete Step | REAIE V“'”mes(o""‘): b2
Add Dissociation Stage l 3

Fig. 21: Creating the temperature profile.

In addition, the Instrument level contains the option Data Collection. By selecting
this option the window depicted in Fig. 22 is opened. Each ramp and each
plateau temperature shows a Data Collection Icon, which illustrates the data
being collected at this stage of the run. Remove all symbols except the one for
the Annealing-Extension step (Stage2/Step?2) by clicking on them in order to
exclude unnecessary fluorescence measurements. The total run time and the
data quantity will thus be kept at a minimum.
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Fig. 22: Data collection.
8.5.3.5 Saving the PCR Run

Save the settings (Setup) as a template in order to make use of them again later
in a modified or unchanged form. By saving the Template file as an ABI PRISM

SDS Template Document (*.sdt) in the Template Directory ([D:]\Program
Files\Applied Biosystems\SDS 2. 1\Templates, created by Applied Biosystems),
this file may be selected directly in the New Document window from the
Template list. Copies stored in other folders have to be opened via Browse.
Before starting the PCR run, save it again as an ABI PRISM SDS Document

(*.sds) in order to guarantee the saving of the data that will be collected during

the course of the PCR.
8.5.3.6 Starting the PCR Run

Start the PCR run by selecting the option Start from the menu item Instrument.

9. Data Analysis

A valid calibration of the dyes (Pure Spectra Component File) and the
background (Background Component File) is necessary when putting the
instruments into operation. These calibration files are required for the exact
calculation of the results as follows:

All interfering signals generated by the instruments which influence the
measurement are eliminated by the Sequence Detection Software of the ABI
PRISM Sequence Detection Systems by means of the Background Component
File.

Furthermore, interferences appear during multicolour analyses between the

emission spectra of the single fluorescence dyes. The software of the ABI PRISM
SDS compensates these interferences by calculations using the spectrum data of

artus VZV TM PCR Kit 03/2015
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the individual dyes stored in the Pure Spectra Component File. The software uses
the same file for the assignment of the fluorescence data comprising the entire
measurable spectrum collected in the course of the PCR to the programmed
detectors. The fluorescence data of the individual dyes are subsequently divided
by the value obtained for the signal of the passive reference (ROX) in order to
account for tube-to-tube variations (fluorescence differences between several
PCR preparations). The thus normalized signals may then be evaluated by
means of the Amplification Plot.

The calibration files used for the evaluation of a PCR run are automatically
stored with the saving of the run. If no calibration files are installed, please
create these files according to the instructions given in the ABI PRISM SDS User
Guide/Manual.

If more than one artus TM PCR system is integrated in your PCR run (note
temperature profile), these assays should be analysed separately. Samples
with an identical Sample Name and an identical detector assignment will
automatically be identified as replicates by the ABI PRISM 7000 and 7900HT
SDS Software and will be averaged with respect to the quantified pathogen
load.

The following results are possible:

1. A FAM fluorescence signal is detected.
The result of the analysis is positive: The sample contains VZV DNA.
In this case, the detection of a VIC fluorescence signal (Internal Control) is
dispensable, since high initial concentrations of VZV DNA (positive FAM
fluorescence signal) can lead to a reduced or absent fluorescence signal of
the Internal Control (competition).

2. No FAM fluorescence signal is detected. At the same time, a VIC
fluorescence signal from the Internal Control appears.
In the sample no VZV DNA is detectable. It can be considered
negative.
In the case of a negative VZV PCR the detected signal of the Internal Control
rules out the possibility of PCR inhibition.

3. Neither a FAM fluorescence signal nor a VIC fluorescence signal is detected.
No diagnosis can be concluded.
Information regarding error sources and their solution can be found in
10. Troubleshooting.

Examples of positive and negative PCR reactions are given in Fig. 23/24 (ABI
PRISM 7000 SDS), 25/26 (ABI PRISM 7700 SDS) and 27/28 (ABI PRISM
7900HT SDS).
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Fig. 23: Detection of the Quantitation Standards (VZV LC/TM QS 1 — 4) by measurement of the
FAM fluorescence signal (ABI PRISM 7000 SDS). NTC: non-template control (negative control).
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Fig. 24: Detection of the Internal Control (IC) by measurement of the VIC fluorescence signal
(ABI PRISM 7000 SDS) with simultaneous amplification of the Quantitation Standards (VZV
LC/TM
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Fig. 25: Detection of the Quantitation Standards (VZV LC/TM QS 1 — 4) by measurement of the
FAM fluorescence signal (ABI PRISM 7700 SDS). NTC: non-template control (negative control).
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Fig. 26: Detection of the Internal Control (IC) by measurement of the VIC fluorescence signal
(ABI PRISM 7700 SDS) with simultaneous amplification of the Quantitation Standards (VZV
LC/TM QS 1 — 4). NTC: non-template control (negative control).

32 artus VZV TM PCR Kit 03/2015



2,000 li ion Plot

1.800

1.800

1.400

1.200

& 1000

8,000 E1

6.000 E1

4.000 E1

2.000 B

0,000 —m=m

Fig. 27: Detection of the Quantitation Standards (VZV LC/TM QS 1 — 4) by measurement of the
FAM fluorescence signal (ABI PRISM 7900HT SDS). NTC: non-template control (negative
control).
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Fig. 28: Detection of the Internal Control (IC) by measurement of the VIC fluorescence signal
(ABI PRISM 7900HT SDS) with simultaneous amplification of the Quantitation Standards (VZV
LC/TM QS 1 — 4). NTC: non-template control (negative control).

10. Troubleshooting
No FAM fluorescence signal with positive controls (VZV LC/TM QS 1 - 4):

B The selected detection dye for PCR data analysis does not comply with the
protocol.

=» For data analysis select the detection dye FAM for the analytical VZV PCR
and the detection dye VIC for the Internal Control PCR.
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B The settings used for the data analysis under Options (Extension Phase
Data Extraction) do not correspond to the settings of the Data Collection
(for ABI PRISM 7700 SDS see 8.5.2.4 Creating the Temperature Profile, for
ABI PRISM 7900HT SDS see 8.5.3.4 Creating the Temperature Profile).

=» Analyse the PCR run with corrected settings and repeat the data analysis
(Analysis).

B Incorrect programming of the temperature profile of the ABI PRISM
Sequence Detection System.

=» Compare the temperature profile with the protocol (see 8.5 Programming
the ABI PRISM SDS).

B Incorrect configuration of the PCR reaction.

=» Check your work steps by means of the pipetting scheme (see
8.4 Preparing the PCR) and repeat the PCR, if necessary.

B The storage conditions for one or more kit components did not comply with
the instructions given in 2. Storage or the artus VZV TM PCR Kit had
expired.

=» Please check the storage conditions and the expiration date (see the kit
label) of the reagents and use a new kit, if necessary.

Weak or no signal of the Internal Control (VIC fluorescence signal) and

simultaneous absence of a FAM fluorescence signal for the specific VZV
PCR:

M The PCR conditions do not comply with the protocol.

=» Check the PCR conditions (see above) and repeat the PCR with corrected
settings, if necessary.

B The PCR was inhibited.

=» Make sure that you use a recommended isolation method (see 8.1 DNA
Isolation) and stick closely to the manufacturer’s instructions.

=» Make sure that during the DNA isolation the recommended additional
centrifugation step has been carried out before the elution in order to
remove any residual ethanol (see 8.1 DNA Isolation).

B DNA was lost during extraction.

=» If the Internal Control had been added to the extraction, an absent signal
of the Internal Control can indicate the loss of DNA during the extraction.
Make sure that you use a recommended isolation method (see 8.1 DNA
Isolation) and stick closely to the manufacturer’s instructions.

34 artus VZV TM PCR Kit 03/2015



B The storage conditions for one or more kit components did not comply with
the instructions given in 2. Storage or the artus VZV TM PCR Kit had
expired.

=» Please check the storage conditions and the expiration date (see the kit
label) of the reagents and use a new kit, if necessary.

A FAM fluorescence signal of the analytical PCR with the negative
controls:

M A contamination occurred during preparation of the PCR.
=» Repeat the PCR with new reagents in replicates.

=» If possible, close the PCR tubes directly after addition of the sample to be
tested.

=» Strictly pipette the positive controls at last.

=» Make sure that work space and instruments are decontaminated at
regular intervals.

B A contamination occurred during extraction.

=» Repeat the extraction and PCR of the sample to be tested using new
reagents.

=» Make sure that work space and instruments are decontaminated at
regular intervals.

If you have any further questions or if you encounter problems, please contact
our Technical Service.

11. Specifications

11.1 Analytical Sensitivity

In order to determine the analytical sensitivity of the artus VZV TM PCR Kit, a
standard dilution series has been set up from 60 to nominal 0.019 VZV copy
equivalents*/ul and analysed by means of the ABI PRISM 7000, 7700 and
7900HT Sequence Detection Systems with the help of the artus VZV TM PCR Kit.
Testing for all instruments was carried out on three different days on eight

replicates. The results were determined by a probit analysis. A graphical
illustration of the probit analysis (ABI PRISM 7700 SDS) is shown in Fig. 29.

* The standard is a cloned PCR product, the concentration of which has been determined by
absorption and fluorescence spectroscopy.

L. |
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Detection limit (p = 0.05)

ABI PRISM 7000 SDS 0.4 copies/ul
ABI PRISM 7700 SDS 0.6 copies/ul
ABI PRISM 7900HT SDS 0.3 copies/ul

This means that there is a 95 % probability that 0.4 copies/ul (ABI PRISM 7000
SDS), 0.6 copies/ul (ABI PRISM 7700 SDS) and 0.3 copies/ul (ABI PRISM
7900HT SDS) will be detected.

-0.21291 2 0.6 copies/pl (95%)

Proportions

2
log (dose)

Fig. 29: Analytical sensitivity of the artus VZV TM PCR Kit (ABI PRISM 7700 SDS).

11.2 Specificity

The specificity of the artus VZV TM PCR Kit is first and foremost ensured by the
selection of the primers and probes, as well as the selection of stringent reaction
conditions. The primers and probes were checked for possible homologies to all
in gene banks published sequences by sequence comparison analysis. The
detectability of all relevant strains has thus been ensured.

Moreover, the specificity was validated with 30 different VZV negative
cereprospinal fluid samples. These did not generate any signals with the VZV
specific primers and probes, which are included in the VZV TM Master.
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To determine the specificity of the artus VZV TM PCR Kit the control group listed
in the following table (see Table 1) has been tested for cross-reactivity. None of
the tested pathogens has been reactive.

Table 1. Testing the specificity of the kit with potentially cross-reactive
pathogens

VZV (FAM) Control
Control group Internal (VIC)
Human herpesvirus 1 - +
(Herpes simplex virus 1)
Human herpesvirus 2 — +
(Herpes simplex virus 2)
Human herpesvirus 4 - +
(Epstein-Barr virus)
Human herpesvirus 5 - +
(Cytomegalovirus)
Human herpesvirus 6A - +
Human herpesvirus 6B
Human herpesvirus 7
Human herpesvirus 8
(Kaposi’s sarcoma-associated
herpesvirus)

11.3 Precision

The precision data of the artus VZV TM PCR Kit allow the determination of the
total variance of the assay. The total variance consists of the intra-assay
variability (variability of multiple results of samples of the same concentration
within one experiment), the inter-assay variability (variability of multiple
results of the assay generated on different instruments of the same type by
different operators within one laboratory) and the inter-batch variability
(variability of multiple results of the assay using various batches). The data
obtained were used to determine the standard deviation, the variance and the
coefficient of variation for the pathogen specific and the Internal Control PCR.

Precision data of the artus VZV TM PCR Kit have been collected using the
Quantitation Standard of the lowest concentration (QS 4; 10 copies/ul). Testing
was performed with eight replicates. The precision data were calculated on
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basis of the Ct values of the amplification curves (Ct: threshold cycle, see Table
2). In addition, precision data for quantitative results in copies/ul were
determined using the corresponding Ct values (see Table 3). Based on these
results, the overall statistical spread of any given sample with the mentioned
concentration is 0.72 % (Ct) or 8.33 % (conc.), for the detection of the Internal
Control 1.40 % (Ct). These values are based on the totality of all single values of
the determined variabilities.

Table 2. Precision data on basis of the Ct values

Standard Coefficient of
deviation Variance variation [%]
Intra-assay variability: 0.13 0.02 0.42
VZV LC/TM QS
Intra-assay variability: 0.08 0.01 0.25
Internal Control
Inter-assay variability: 0.13 0.02 0.40
VZV LC/TM QS 4
Inter-assay variability: 0.20 0.04 0.64
Internal Control
Inter-batch variability: 0.30 0.09 0.93
VZV LC/TM QS 4
Inter-batch variability: 0.61 0.37 1.98
Internal Control
Total variance: 0.23 0.05 0.72
VZV LC/TM QS 4
Total variance: 0.43 0.18 1.40
Internal Control
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Table 3. Precision data on basis of the quantitative results (in copies/pl)

Coefficient
Standard of variation
deviation Variance [%]
Intra-assay variability: 0.95 0.91 9.48
VZV LC/TM QS 4
Inter-assay variability: 0.70 0.48 6.93
VZV LC/TM QS 4
Inter-batch variability: 0.96 0.91 9.52
VZV LC/TM QS 4
Total variance: 0.84 0.70 8.33
VZV LC/TM QS 4

11.4 Robustness

The verification of the robustness allows the determination of the total failure
rate of the artus VZV TM PCR Kit. 30 VZV negative samples of cerebrospinal
fluid were spiked with 1.8 copies/ul elution volume of VZV control DNA
(threefold concentration of the analytical sensitivity limit). After extraction using
the QIAamp DNA Mini Kit (see 8.1 DNA Isolation) these samples were analysed
with the artus VZV TM PCR Kit. For all VZV samples the failure rate was 0 %. In
addition, the robustness of the Internal Control was assessed by purification and
analysis of 30 VZV negative cereprospinal fluid samples. The total failure rate
was 0 %. Thus, the robustness of the artus VZV TM PCR Kit is = 99 %.

11.5 Reproducibility

Reproducibility data permit a regular performance assessment of the artus VZV
TM PCR Kit as well as an efficiency comparison with other products. These data
are obtained by the participation in established proficiency programmes.

11.6 Diagnostic Evaluation

Currently, the artus VZV TM PCR Kit is undergoing a series of evaluation studies.
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12. Product Use Limitations
M All reagents may exclusively be used in in vitro diagnostics.

B The product is to be used by personnel specially instructed and trained in
the in vitro diagnostics procedures only.

M Strict compliance with the user manual is required for optimal PCR results.

B Attention should be paid to expiration dates printed on the box and labels
of all components. Do not use expired components.

13. Warnings and Precautions

For safety information of the artus VZV TM PCR Kit, please consult the
appropriate safety data sheet (SDS). The SDSs are available online in
convenient and compact PDF format at www.qiagen.com/safety.

14. Quality control

In accordance with QIAGEN's ISO 9001 and ISO 13485-certified Quality
Management System, each lot of artus VZV TM PCR Kit has been tested against
predetermined specifications to ensure consistent product quality.

15. References
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16. Explanation of Symbols
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artus VZV TM PCR Kit

Trademarks and Disclaimers

QIAGEN®, QIAamp®, artus®, BioRobot®, EZ1%, UltraSens® (QIAGEN Group); ABI PRISM®, MicroAmp®, GeneAmp® (Life Technologies Corporation).
Registered names, trademarks, etc. used in this document, even when not specifically marked as such, are not to be considered unprotected by law.

The artus VZV TM PCR Kit, the BioRobot EZ1 Workstation, and the EZ1 DSP Virus Kit and Card are CE-marked diagnostic devices according to the
European In Vitro Diagnostic Directive 98/79/EC. Not available in all countries.

The QlAamp Kits are intended for general laboratory use. No claim or representation is intended to provide information for the diagnosis,
prevention, or treatment of a disease.

Purchase of artus PCR Kits is accompanied by a limited license to use them in the polymerase chain reaction (PCR) process for human and veterinary
in vitro diagnostics in conjunction with a thermal cycler whose use in the automated performance of the PCR process is covered by the up-front
license fee, either by payment to Applied Biosystems or as purchased, i.e. an authorized thermal cycler. The PCR process is covered by the foreign
counterparts of U.S. Patents Nos. 5,219,727 and 5,322,770 and 5,210,015 and 5,176,995 and 6,040,166 and 6,197,563 and 5,994,056 and
6,171,785 and 5,487,972 and 5,804,375 and 5,407,800 and 5,310,652 and 5,994,056 owned by F. Hoffmann-La Roche Ltd.
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